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How to find help

1.1 Find help in the box
1.1.1 Use the print manual
A large print manual is included in the box containing your Hal software.
This book contains information on getting started with Hal, covering the
installation and set-up of the software, and an explanation of the features
within the product.
1.1.2 Use the DAISY manual
The full manual is available as a DAISY Digital Talking Book (DTB). You
can find this on a CD in the product box. The CD can be played on either
your hardware DAISY player, or on your computer, using the supplied
Dolphin EasyReader software also contained on the CD.
A DAISY book is a type of Talking Book that contains synchronised text
and speech. Using the supplied EasyReader software, you can navigate
the book by sentence, chapter or heading, and even create your own
bookmarks.

1.2 Get help using Hal with your application
Hal Help describes how to use Hal with many popular Windows
applications. While Hal is running, you can open the Hal Help directly at
any time from within your application. When you open the Hal Help menu,
the first item will link to specific information about using Hal with the current
application.
To do this:
1. Press CAPS LOCK + F1 to open Hal Help.
2. DOWN ARROW to select the name of your application. For example,
Microsoft Word 2007.
3. Press ENTER to open the selected item.
001HGUGPB50
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When you wish to return to your application, you can press ALT + F4 to
close the Help window.
1.2.1 Move within Help topics
You can use Arrow Keys to move around within topics. In addition, you can
use the following web page navigation commands to move around within
help topics. Visit the Internet Explorer section of the Hal manual for a
complete list of hot keys for moving around web pages.
· Move to the next heading, H.
· Move to the previous heading, SHIFT + H.
· Move to the next link, TAB.
· Move to the previous link, SHIFT + TAB.
· Move to the bottom of the current document, CONTROL + END.
· Move to the top of the current document, CONTROL + HOME.
· Read from here to the end of the document, press the Read From
Here hot key.
Read From Here
Function

Start Read From Here

Stop Read From Here

Desktop Default
NumPad Set
NUMPAD
PLUS
NUMPAD
PLUS
or ESCAPE
or LEFT
CONTROL

Laptop Universal Set
CAPS LOCK +
DOWN
ARROW
SPACEBAR
or ESCAPE
or CONTROL

When you wish to return to your application, you can press ALT + F4 to
close the Help window.
1.2.2 Move between Help topics
You can use the links at the top of each topic to go to the next or previous
topic.
To do this:
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1. Press CONTROL + HOME to move to the top of the document.
2. Press TAB to move by link until you hear "Previous Topic Link" or "Next
Topic Link". You can press SHIFT + TAB to move back to any links you
may have skipped.
3. Follow the link you have chosen by pressing ENTER.
You can use the "Home" link to move to a page containing links to all topics
relating to the current application.
When you wish to return to your application, you can press ALT + F4 to
close the Help window.
1.2.3 Switch between Help and your application
You can remember your place in the Hal Help by keeping the Hal Help
Browser window open. You may find it useful to switch between the Hal
Help Browser window and your application window several times while
carrying out help instructions.
To do this:
1. From the Hal Help window, press ALT + TAB to switch back to your
application.
2. Carry out any actions in your application.
3. Press ALT + TAB to return to your position in the Help window.
When you have finished using Hal help, you can press ALT + F4 to close
the Help window.

1.3 Get Help from the Hal Control Panel
Your Hal Control Panel provides two ways of getting help.
· The Help button.
· The Help menu.
1.3.1 Use the Help Button
The Help button in the Hal Control Panel is context sensitive. When you
press this button, Hal opens the relevant section of the manual containing
an explanation of the Hal settings in view.
If the Hal Control Panel is not open, you can open it using LEFT CONTROL
+ SPACEBAR.
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You can press the Help button in any of these ways:
· Left clicking the "Help" button on the Control Panel with the mouse.
· TAB to the "Help" button and press SPACEBAR.
· Press F1.
1.3.2 Explore the Help menu
The Help menu provides access to the complete Hal manual. The complete
manual is particularly useful when you need to lookup a particular piece of
information.
1. If the Hal control panel is not open, you can open it using LEFT
CONTROL + SPACEBAR.
2. When in the Hal control panel, press ALT + H to open the "Help" menu.
The first item in the menu is "Hal Manual".
3. Press ENTER to open the Hal manual.
Use the following keys to navigate the Hal manual:
· Choose a section, UP and DOWN ARROW Keys.
· Expand and collapse individual sections, RIGHT and LEFT ARROW
Keys.
· Open a topic, ENTER.
· Move between the contents and the open topic, F6.

1.4 Get support for Hal
1.4.1 Find help on the Dolphin website
The Dolphin website offers a comprehensive range of support materials to
help you get the most out of your Dolphin product. A variety of
documentation is available, from handy tips and tutorials, to more technical
knowledge base articles offering solutions to less common problems.
To do this:
1. Open a web browser and visit http://www.YourDolphin.com.
2. Choose the "Support" link from the main navigation menu.
3. Choose one of the options available to you:
· Manuals and user guides. Dolphin's training Manuals and Quick Start
Guides will help you get to grips with our products quickly and easily.
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· Tips & Tutorials. Handy step by step online tutorials covering the main
product features.
· Knowledge Base. The Knowledge Base is a searchable database
containing a wealth of information and solutions to issues you might
have with your Dolphin product.
1.4.2 Contact your Dolphin Dealer for support
If you purchased your Dolphin software from a registered Dolphin dealer,
you can contact the dealer directly to receive the most appropriate localised
support. If you do not know the contact details for your dealer, you can
obtain these from the Dolphin website.
To do this:
1. Open a web browser and visit http://www.YourDolphin.com.
2. Choose the "Dealers" link from the main navigation menu. This will
open the "Dealer Locator" page.
3. Select your country from the list then choose the "Submit" button. This
will open a page displaying a list of Dolphin Dealers for that country.
4. Review the results to locate the contact details for the dealer from which
you purchased your Dolphin product.
1.4.3 Contact Dolphin UK Product Support
At Dolphin we pride ourselves in the quality and level of Product Support
we provide to all our customers. Our goal is to continue to provide Product
Support that is second to none. You can contact our Product Support team
in a number of ways.
To do this:
· By telephone: +44 (0)1905 754765.
· By telephone (UK Local Rate): 0845 130 5454.
· By Fax: +44 (0) 1905 754 559.
· By Email: support@dolphinuk.co.uk.
1.4.4 Contact Dolphin USA Product Support
At Dolphin we pride ourselves in the quality and level of Product Support
we provide to all our customers. Our goal is to continue to provide Product
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Support that is second to none. You can contact our Product Support team
in a number of ways.
To do this:
· By telephone (Toll free): +1 (888) 519 4694.
· By telephone (US Local Rate): +1 (609) 803 2171.
· By Email: support@dolphinusa.com.
1.4.5 Get further product training
Dolphin has a network of approved trainers who are available to offer you
high quality training either within your home or in your place of work. Our
trainers can personalise the training to your individual requirements
allowing you to maximize your independence, whilst taking into account
your level of technical knowledge. You can contact Dolphin to find a
Dolphin approved trainer in your area.
To do this:
· By telephone: +44 (0)1905 754577.
· By Email: info@dolphinuk.co.uk.
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2.1 Install and Set Up
2.1.1 Install Hal
Note: If you are installing the network version of Hal, then please go
to Network Hal (page 53).
You can install Hal in just a few steps. The installation program will show
messages in a large font and reads all instructions aloud.
The installation program will install the following:
· Hal
· Dolphin Synthesizer Access Manager (SAM)
· Voices
If you want speech at the Windows Logon, install Dolphin Orpheus TTS.
Dolphin Orpheus TTS is a synthetic Voice.
You have three install options:
1. Install as a new user.
2. Install as an existing user wanting a new install.
3. Install as an existing user wanting to upgrade.
Install as a new user
Before You Install
You must have full permission to install software in Windows to
successfully install Hal. If you do not have full permission then please
contact your System Administrator.
Windows Vista and Windows 7

001HGUGPB50
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In Windows Vista and Windows 7 the User Access Control (UAC) will ask
you to confirm that you want to run the installation program. There is no
speech support at this stage.
If you need assistance to close the UAC Run Windows Narrator.
To run Windows Narrator:
1. Press WINDOWS
Utility Manager.

KEY + U. This will open the Windows

2. Press ALT + N. This will start Windows Narrator.
To install Hal:
1. Insert the Hal CD into your CD-ROM drive.
The installation program will start after a short time. If the installation
program does not start, you will need to start it yourself.
To do this:
1A. Press WINDOWS KEY + E. This will open Windows Explorer.
1B. Use the Arrow Keys to select the CD-ROM drive.
1C. TAB to the list of files and folders and use the Arrow Keys to
select "setup.exe".
1D. Press ENTER to start the install program.
2. In the install program, select the install language.
3. Select the product version: "Single User" or "Network". By default, the
installation program selects the "Single User" version for you.
Now shown on the screen is a "Welcome" dialog box. The
installation program tells you the information on how to use the
installation.
4. Follow the instructions to complete the installation.
5. Re-start the computer if the installation program tells you.
The installation is now complete. You can now logon as the registered user
and run Hal.
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Install as an existing user wanting a separate install
Before You Install
You must have full permission to install software in Windows to
successfully install Hal. If you do not have full permission then please
contact your System Administrator.
Installing Hal as a new version means it will exist as a separate product on
your computer. It will not automatically use your existing Hal settings.
To install Hal:
1. Insert the Hal CD into your CD-ROM drive.
The installation program will start after a short time. If the installation
program does not start, you will need to start it yourself.
To do this:
1A. Press WINDOWS KEY + E. This will open Windows Explorer.
1B. Use the Arrow Keys to select the CD-ROM drive.
1C. TAB to the list of files and folders and use the Arrow Keys to
select "setup.exe".
1D. Press ENTER to start the install program.
2. In the install program, select the install language.
3. Select the product version: "Single User" or "Network". By default, the
installation program selects the "Single User" version for you.
Now shown on the screen is a "Welcome" dialog box. The
installation program tells you the information on how to use the
installation.
4. Follow the instructions to complete the installation.
5. Re-start the computer if the installation program tells you.
The installation is now complete. You can now logon as the registered user
and run Hal.
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Install as an existing user wanting to upgrade
Before You Install
You must have full permission to install software in Windows to
successfully install Hal. If you do not have full permission then please
contact your System Administrator.
This will install the new version directly over your old one. This allows you
to keep your preferred settings. Also, you do not have to re-enter your
name, company and installation directory details again.
To install Hal:
1. Insert the Hal CD into your CD-ROM drive.
The installation program will start after a short time. If the installation
program does not start, you will need to start it yourself.
To do this:
1A. Press WINDOWS KEY + E. This will open Windows Explorer.
1B. Use the Arrow Keys to select the CD-ROM drive.
1C. TAB to the list of files and folders and use the Arrow Keys to
select "setup.exe".
1D. Press ENTER to start the install program.
2. In the install program, select the install language.
3. Select the product version: "Single User" or "Network". By default, the
installation program selects the "Single User" version for you.
Now shown on the screen is a "Welcome" dialog box. The
installation program tells you the information on how to use the
installation.
4. Follow the instructions to complete the installation.
5. Re-start the computer if the installation program tells you.
The installation is now complete. You can now logon as the registered user
and run Hal.
Uninstall a single user version of Hal
Before uninstalling Hal it is first necessary to close it down.
To do this:
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1. Press LEFT CONTROL+ SPACEBAR.
2. Press ALT + F. This will open the "File" menu.
3. DOWN ARROW to "Quit Hal" and press ENTER. A message window
will appear asking you to confirm you want to quit.
4. TAB to the "Yes" button and press SPACEBAR.
Once you have closed Hal
1. Open the Windows Control Panel.
2. Choose "Add/Remove Programs".
3. DOWN ARROW to select "Dolphin Hal" in the list of programs.
The Uninstall program will run.
4. Follow the steps to remove Hal from your computer.
Removing Hal does not remove your personal settings. To remove your
personal settings:
1. Press WINDOWS KEY + E.
2. Open your "Local Settings" folder.
3. Open the "Application Data" folder.
4. Open the "Dolphin" folder.
5. Open the Hal folder.
6. Select the "Settings" folder.
7. Press DELETE.
You will also need to remove Dolphin SAM and any Voices installed. You
can remove these components through the "Add / Remove Programs" list
in the Windows Control Panel.
2.1.2 Start Hal
Hal will start automatically after you log onto your computer unless you
have stated otherwise during the installation process.
You can manually start Hal after log on by using the Hal shortcut key.
Press CONTROL + SHIFT + H.
If you have installed a new version alongside your existing version then the
new version will be automatically given the following shortcut key:
Press CONTROL + SHIFT + D.
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You can also launch Hal by selecting the Hal shortcut in the Windows Start
menu. This is in the Programs, Dolphin sub-menu.
2.1.3 Run Hal for the first time
You will be guided through the setup process the first time you run Hal after
installation.
The setup process will guide you through:
· Unlocking and activating.
· Changes to the Hal defaults settings.
· Customer feedback options.
· Checking for the latest Hal product updates.
You can choose to go through all the steps, skip some or cancel the setup
process. You can run each step in the setup process at a later date from
the "Help" menu in the Hal control panel.
2.1.4 Learn your hot keys
You can use the Hal Key Describer to help you get familiar with your
keyboard layout and Hal hot keys.
An application will not see or act on any keys pressed when you use Key
Describer.
To turn on or off "Key Describer":
Key Describer Hot Keys
Function

Turn on or off Key Describer

Desktop Default
NumPad Set
CAPS LOCK +
SLASH

Laptop Universal Set
CAPS LOCK +
1

2.1.5 Quit Hal
To quit Hal:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
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2. Press ALT + F. This will open the "File" menu.
3. DOWN ARROW to "Quit Hal" and press ENTER. A message window
will appear asking you to confirm you want to quit.
4. TAB to the "Yes" button and press SPACEBAR.

2.2 Use the Hal control panel
2.2.1 What is the Hal control panel?
The Hal control panel is the dialog box that contains all of the settings for
Hal.
2.2.2 Open the Hal control panel
To open the Hal control panel
Press LEFT CONTROL + SPACEBAR.
2.2.3 Open a pop up menu style Hal control panel
To open a pop up menu style version of the Hal control panel:
Press CAPS LOCK + SPACEBAR.
2.2.4 Close the Hal control panel
To exit the control panel press ESCAPE or click on the minimize button.
When you close the control panel, Hal will continue to run.
2.2.5 Change control panel appearance
You can change the appearance of the control panel by choosing to show
or hide the button bar.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + G. This will open the "General" menu.
3. DOWN ARROW to "Control Panel" and press ENTER. This will open
the "Control Panel" dialog box.
4. Choose the "Menu bar" radio button to hide the button bar or choose
"Button bar style" radio button to show the button bar.
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5. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
The new control panel style is applied. You can also switch between the
styles by choosing the style button in the Hal control panel menu bar.

2.3 Change Voice settings
2.3.1 Turn the voice off or on

You can turn off or on the voice using the "Speech" options in the Hal
control panel or by using hot keys.
To turn off the voice until you turn on the voice again:
Speech Hot Keys
Function

Turn voice on and off

Mute voice

Desktop Default
NumPad Set
LEFT
CONTROL + 0
LEFT
CONTROL

Laptop Universal Set
LEFT
CONTROL +
ALT + 0
CONTROL

2.3.2 Change volume

You can change the volume of the voice using the "Speech" options in the
Hal control panel or by using hot keys.
Speech Hot Keys
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Function

Increase volume

Decrease volume

Desktop Default
NumPad Set
LEFT
CONTROL +
EQUALS
LEFT
CONTROL +
MINUS

Laptop Universal Set
LEFT
CONTROL +
ALT + EQUALS
LEFT
CONTROL +
ALT + MINUS

2.3.3 Change reading speed

You can change the reading speed of the voice using the "Speech" options
in the Hal control panel or by using hot keys.
Speech Hot Keys
Function

Increase reading speed

Reduce reading speed

Desktop Default
NumPad Set
LEFT
CONTROL +
LEFT SHIFT +
EQUALS
LEFT
CONTROL +
LEFT SHIFT +
MINUS

Laptop Universal Set
LEFT
CONTROL +
ALT + PAGE
UP
LEFT
CONTROL +
ALT + PAGE
DOWN

2.3.4 Change reading voice language

You can read text from the screen in a different language by changing the
language set for the Hal Screen Language. You will be able to change to
any language supported by your synthesizer.
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You can change the "Screen Language" using the "Speech" options in the
Hal control panel or by using hot keys.
To change "Screen Language":
Press LEFT CONTROL + COMMA to move forward through the
available languages.
Press LEFT CONTROL + PERIOD to move back through the
available languages.
To learn more about available synthesizer languages please visit the
Dolphin web site.
2.3.5 Change voice

Speech synthesizers often come with different voices to choose from. Each
voice will have its own intonation, created within the speech parameters
available.
To change voice:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "Voice Preferences" and press ENTER. This will
open the "Voice Preferences" dialog box.
4. CONTROL + TAB to open the "Voice and Language Configuration" tab.
5. Select the voice you want to use in each Hal category.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
If you are unable to find a voice you find comfortable to listen to then you
should try an alternative synthesizer or try creating your own voice in the
"User Defined Voices" tab, in the "Voice Preferences" dialog box.
2.3.6 Change speech synthesizer
Hal works with many different speech synthesizers. Supporting such a
variety of speech synthesizers means you can pick a synthesizer and voice
that you find comfortable, clear and responsive to use. To see what speech
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synthesizers are available please visit the Dolphin website or contact your
local Dolphin Dealer.
To change to another speech synthesizer:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "Voice Preferences" and press ENTER. This will
open the "Voice Preferences" dialog box.
4. CONTROL + TAB to the "Synthesizer Configuration" tab.
5. TAB to the "Select Synthesizer" button and press SPACEBAR. This will
open the "Select Synthesizer" dialog box.
6. Use the Arrow Keys to select an alternative speech synthesizer.
7. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box. You return to the "Voice
Preferences" dialog box.
If you find the voice not to your liking then you can move into the "Voice
and Language Configuration" property sheet to choose a different voice.
You could also move to the "User defined voices" property sheet to
customise the parameters of the existing voice.

2.4 Reading and typing basics
2.4.1 Speak the keys you press
You can add key announcements to your key presses. This can provide
reassurance when using your keyboard.
To use Key Echo:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "Keyboard Announcements" and press ENTER.
This will open the "Keyboard Announcements" dialog box.
4. Press SPACEBAR to deselect the "Automatic key echo" check box.
5. TAB to the "Selected key echo" group and select the key groupings you
want spoken when pressed.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
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2.4.2 Change what is spoken when typing
You can have:
· Each character you type spoken.
· Each word you type spoken.
· Each character and word you type spoken.
· Nothing spoken when typing.
You can make this change through the Hal control panel.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "Character Echo" and press ENTER. This will open
the "Character Echo" dialog box.
4. Select what you want spoken when typing from the options available.
5. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
You can also change the Character Echo value using a Hal hot key.
Press CAPS LOCK + SEMI COLON to change what is spoken when
typing.
2.4.3 Read continuously
Read From Here is a special reading mode available in Hal.
You can use Read From Here to continuously read a document. Reading
will continue until the end of the document or until you press a hot key to
stop the reading. The pressing of a hot key to stop Hal reading will move
the cursor to the last word spoken.
Read From Here
Function

Start Read From Here

Desktop Default
NumPad Set
NUMPAD
PLUS

Laptop Universal Set
CAPS LOCK +
DOWN
ARROW
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Stop Read From Here

NUMPAD
PLUS
or ESCAPE
or LEFT
CONTROL

SPACEBAR
or ESCAPE
or CONTROL

Read From Here is also available when using the Dolphin Cursor. This
allows you to continuously read information that you may not otherwise be
able to read including web pages, dialog boxes, lists and menus.
You can also turn on or turn off the Dolphin Cursor when you stop Read
From Here. Turning on the Dolphin Cursor will place the Dolphin Cursor on
the last word spoken. The application does not move focus to the new
position.
Read From Here
Function

Stop Read From Here and
turn on or turn off the Dolphin
Cursor

Desktop Default
NumPad Set
NUMPAD
MINUS

Laptop Universal Set
SPACEBAR

2.4.4 Read character
Speak Key
Function

Read character at the current
focus position

Desktop Default
NumPad Set
NUMPAD 4

Laptop Universal Set
CAPS + LEFT
ARROW

You can learn more about the current character by repeating the press of
the hot key.
· x2 announces the phonetic character description.
· x3 announces the character's attributes including font name, size and
style.
· x4 announces the unicode value of the character.
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2.4.5 Read word
Speak Key
Function

Read word at the current
focus position

Desktop Default
NumPad Set
NUMPAD 5

Laptop Universal Set
CAPS LOCK +
RIGHT
ARROW

You can learn more about the current word by repeating the press of the
hot key.
· x2 spells the word.
· x3 spells the word using the phonetic alphabet.
2.4.6 Read line, read line to cursor and read line from cursor
You can read the current line, read up to the cursor position on the current
line and read from the cursor position on the current line.
Speak Key
Function

Read line at the current focus
position
Read up to the cursor
position on the current line
Read from the cursor position
on the current line

Desktop Default
NumPad Set
NUMPAD 6
LEFT SHIFT +
NUMPAD 1
LEFT SHIFT +
NUMPAD 2

Laptop Universal Set
CAPS LOCK +
UP ARROW
CAPS LOCK +
HOME
CAPS LOCK +
END

You can learn more about the current line by repeating the press of the hot
key.
· x2 reads the line including announcements of capital letters and
spaces.
· x3 spells the line.

Hal User Guide 27

2.4.7 Read selected text
You can read the text you have selected in your document with a hot key.
Speak Key
Function

Read selected text

Desktop Default
NumPad Set
NUMPAD 1

Laptop Universal Set
CAPS LOCK +
SHIFT +
DOWN
ARROW

You can learn more about the current selection by repeating the press of
the hot key.
· x2 spells the selected text including announcements of capital letters
and spaces.
· x3 spells the selected text using the phonetic alphabet.
2.4.8 Read focus
Speak Key
Function

Read current focus

Desktop Default
NumPad Set
NUMPAD 0

Laptop Universal Set
No Assignment

You can learn more about the current focus by repeating the press of the
hot key.
· x2 spells the focus including announcements of capital letters and
spaces.
· x3 spells the focus using the phonetic alphabet.
2.4.9 Read control
Speak Key
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Function

Read control

Desktop Default
NumPad Set
NUMPAD
PERIOD

Laptop Universal Set
No Assignment

You can learn more about the current control by repeating the press of the
hot key.
· x2 reads the control including announcements of capital letters and
spaces.
· x3 spells the control using the phonetic alphabet.
2.4.10 Read window
Speak Key
Function

Read WINDOW

Desktop Default
NumPad Set
NUMPAD 9

Laptop Universal Set
CAPS LOCK +
B

You can learn more about the current window by repeating the press of the
hot key.
· x2 spells the focus including announcements of capital letters and
spaces.
2.4.11 Read status
Speak Key
Function

Read status information (e.g.
status bar)

Desktop Default
NumPad Set
NUMPAD 2

Laptop Universal Set
CAPS LOCK +
PAGE DOWN
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You can learn more about the current status by repeating the press of the
hot key.
· x2 spells the status including announcements of capital letters and
spaces.
· x3 spells the status using the phonetic alphabet.
You may have additional commands added to this hot key for different
applications. Please refer to the help for the application to learn more.
2.4.12 Read shortcut key
Speak Key
Function

Describe shortcut key

Desktop Default
NumPad Set
LEFT SHIFT +
NUMPAD
PERIOD

Laptop Universal Set
CONTROL +
CAPS LOCK +
LEFT ARROW

You can learn more about the current shortcut key by repeating the press
of the hot key.
· x2 spells the shortcut key using the phonetic alphabet.
2.4.13 Read date and time
You can announce the current time and date with a Hal hot key. The time
and date comes from your computer clock.
Speak Key
Function

Read time and date

Desktop Default
NumPad Set
LEFT
CONTROL +
LEFT SHIFT +
NUMPAD
SLASH

Laptop Universal Set
CAPS LOCK +
F12
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2.4.14 Check where you are
You can learn where you are by pressing the "Where Am I" hot key.
Pressing The hot key gives different information depending on your current
location.
Examples:
· The "Where Am I?" hot key tells you the window title, document name
and current line in a word processor.
· The "Where Am I?" hot key tells you the window title, property sheet
name, group name and the name of the current control in a dialog
box.
Speak Key
Function

Where Am I?

Desktop Default
NumPad Set
NUMPAD 7

Laptop Universal Set
CAPS LOCK +
PAGE UP

2.4.15 Change what Hal tells you about each type of control

You can control what Hal automatically tells you about a button, a check
box, a menu item or any other type of control by changing your Verbosity
Level. The lower the Verbosity Level, the less information Hal automatically
announces about the control.
To change Verbosity Level:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "Verbosity Level" and RIGHT ARROW to open the
sub-menu.
4. Select an item and press ENTER to confirm your change and close the
menu.
You can also change Verbosity Level using a Hal hot key.
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Speech Hot Key
Function

Verbosity Scheme cycle

Desktop Default
NumPad Set
caps lock +
equals

Laptop Universal Set
CAPS LOCK +
V

2.4.16 Change how repeated characters are read
You can change the way Hal reads repeated characters that may appear
on a line. You can have characters like dashes or plus signs individually
spoken, read as a numeric value or indicated with a sound.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "General Announcements" and press ENTER. This
will open the "General Announcements" dialog box.
4. TAB to the "Repeats" button and press SPACEBAR. This will open the
"Repeats" dialog box.
5. Choose how Hal should read repeated characters by selecting from the
options available.
6. TAB to the "Close" button and press SPACEBAR. This will confirm your
changes and closes the dialog box.
To have Hal use your settings requires you to have "Repeats" check box
selected in the "Text Style Announcements" dialog box.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + S. This will open the "Speech" menu.
3. DOWN ARROW to "Text Style Announcements" and press ENTER.
This will open the "Text Style Announcements" dialog box.
4. For each area you want your repeat settings used, TAB to the
"Repeats" check box and press SPACEBAR to select this item.
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5. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.

2.5 Change Braille settings
2.5.1 Turn Braille output off or on

You can turn off or on Braille output using the "Braille" options in the Hal
control panel or by using hot keys.
To turn Braille output off or on:
Press LEFT CONTROL + LEFT SHIFT + 0.
2.5.2 Show capital letters
Some versions of Literary Braille denote capital letters by prefixing the
letter or contraction with a special sign called a Capital Sign. Other versions
of Literary Braille permit the omission of any such notation, thus saving
space.
To show or hide the displaying of the capital letter sign in Literary Braille:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the Braille menu.
3. DOWN ARROW to "Characters" and RIGHT ARROW to open its
sub-menu.
4. Select "Options" and press ENTER. This will open the "Characters"
dialog box.
5. In the "Literary" group box select "Show Capitals" to display the Capital
Sign. Unselect this option to hide the Capital Sign.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
In addition to the selection of the "Show Capitals" check box and
irrespective of Computer Braille and Literary Braille is the option to
"Tremble capitals". This check box is also in the "Characters" dialog box.
Choosing this check box will mean any capital letters will blink. You can
control the rate of blinking by the "Blink rate" setting in the "Cursor" dialog
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box. Blinking capitals in 6-dot Braille is especially useful because Computer
Braille often uses dots 7 or 8 to denote capital letters.
2.5.3 Show cursor position
You can indicate the cursor position on your Braille display. This can be
useful in edit areas.
To show the cursor position on the Braille display:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Cursor" and RIGHT ARROW to open its sub-menu.
4. Select "Visible" and press ENTER to select this item.
To turn off showing the cursor position, simply repeat the steps above and
deselect the "Visible" menu item.
You can also show or hide the cursor position by using a Braille button
command. Please refer to your Braille display commands for further details.
2.5.4 Show enhanced characters (bold, italic, etc.)
You can indicate any enhanced characters on your Braille display by
adding dot 8 to the cell. An enhanced character is any character other than
normal, like a bold character, an underlined character or a character in a
different size font or different color font.
One example where this can be useful is to find out the shortcut key for
menu items and controls in dialog boxes. The underlined letter has dot 8
added to it.
To turn Enhanced Display Mode on:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Characters" and RIGHT ARROW to open its
sub-menu.
4. Select "Enhanced" and press ENTER to select this item.
To turn off showing enhanced characters, simply repeat the steps above
and deselect the "Enhanced" menu item.
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You can also show or hide Enhanced Characters by using a Braille button
command. Please refer to your Braille display commands for further details.
You set what is an enhanced character in the "Characters" dialog box. You
open the "Characters" dialog box by selecting the "Options" item in the
"Characters" sub-menu. This dialog box contains an "Enhanced
Characters" group.
2.5.5 Turn off focus tracking
In normal operation, Braille output shows the focus. Hal calls this "tracking
the focus".
You can turn tracking the focus off. This has the effect of leaving the Braille
display "locked" on a particular area of the screen. For example, you could
turn Tracking off and monitor the progress of an Internet download.
To turn off Tracking:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu.
4. Select "Tracking" and press ENTER to deselect this item.
To turn on Tracking, simply repeat the steps above and select the
"Tracking" menu item.
You can also turn off or on Tracking by using a Braille button command.
Please refer to your Braille display commands for further details.
Notes:
· Turning Tracking off switches you into Braille Physical Mode. You
return to your previous Braille mode when you turn Tracking on again.
· You can continue to move around with Tracking turned off.
2.5.6 Show the physical make up of the screen
There are two ways of positioning information on your Braille display.
· Logical Mode.
This is the default mode used by Hal. In this mode the Braille display
will show the logical association of any incidental text with the focus.
This is similar to the speech output. The nature of Logical Mode
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means that the Braille display will not show the position of items on
the screen.
· Physical Mode.
This mode provides the opportunity to determine the physical layout of
objects on the screen. In Physical mode, you can either show the
characters on the line and the gaps between them (useful for general
layout), or show a more precise layout of the position of the
characters on the line (useful for precise document formatting).
To turn on Physical Mode:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu.
4. Select "Physical Mode" and press ENTER to select this item.
To turn on Logical Mode, simply repeat the steps above and deselect the
"Physical Mode" item.
You can also switch modes by using a Braille button command. Please
refer to your Braille display commands for further details.
You set how Physical Mode shows the make up of the screen in the
"Layout" dialog box. You open the "Layout" dialog box by selecting the
"Options" item in the "Layout" sub-menu.
2.5.7 Choose Computer Braille or Literary Braille
Hal supports two forms of Braille output:
· Computer Braille.
Computer Braille strictly uses one Braille cell per character, whatever
that character is. It is of most use in applications where every
character is of importance, you need to distinguish each possible
character and space is not at a premium.
· Literary Braille.
Literary Braille takes advantage of letter combinations in a language
and forms them into contractions, thus saving space. The term
Literary Braille covers both grade 1 and grade 2 Braille tables. Literary
Braille is of most benefit reading ordinary text.
To change to Literary Braille:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
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2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Characters" and RIGHT ARROW to open its
sub-menu.
4. Select "Literary" and press ENTER to select Literary Braille output.
To change to Computer Braille, simply repeat the steps above and deselect
the "Literary" menu item.
You can also switch between Literary Braille and Computer Braille by using
a Braille button command. Please refer to your Braille display commands
for further details.
2.5.8 Input using your Braille display

Some Braille displays have a group of six or eight buttons arranged like a
Braille writer. You can use these to simulate typing on your computer
keyboard.
Input can be either using Computer Braille or Literary Braille.
To turn Braille Input on or off:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu.
4. Select "Braille Keys" and press ENTER.
Deselect this menu item to turn off Braille input.
Input will be Computer Braille unless "Literary Input" is also selected in the
same "Input" menu.
You can also press the "Toggle Input" command that is assigned to your
Braille display buttons to turn on or off Braille input.
2.5.9 Change Braille table
To change to another Braille translation table:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
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2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "General Preferences" and press ENTER. This will
open the "General Preferences" dialog box.
4. CONTROL + TAB to the "Translation Tables" tab.
Here you can set a language for the "Unicode to Braille Conversion"
table and a language for the "Unicode to Literary Braille Conversion"
table.
5. TAB to the list you want to change and use the Arrow Keys to select a
table.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
2.5.10 Change Braille display
Hal works with many different Braille displays. To see what Braille displays
are supported please visit the Dolphin web site or contact your local
Dolphin Dealer.
To change to another Braille display:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "General Preferences" and press ENTER. This will
open the "General Preferences" dialog box.
4. CONTROL + TAB to the "Braille Configuration" tab.
5. TAB to the "Select Braille Display" button and press ENTER. This will
open a dialog box that lists all Braille displays currently detected by Hal.
6. Use the Arrow Keys to select an alternative Braille display.
7. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box. You return to the "General
Preferences" dialog box.
Your new Braille display should now be in operation.
If your new Braille display is not listed by Hal:
· Check you have successfully connected your Braille display to your
computer.
· Check you have successfully followed any Braille display install and
setup procedures recommended by the display manufacturer.
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· Check Dolphin SAM detects the device. To check that Dolphin SAM is
configured correctly go to the "General" menu in the Hal control panel
and select the "Advanced Options" menu item. In the "General
Advanced Options" dialog box open the "System Configuration"
property sheet and then select the "SAM Setup" button.
If problems persist please contact your Braille display supplier for
assistance.

2.6 Braille reading basics
2.6.1 Learn what your Braille buttons do
You can use the Hal Key Describer to help you get familiar with your Braille
display. An application will not see or act on any keys pressed when you
use Key Describer.
To turn on or off "Key Describer":
Press CAPS LOCK + SLASH.
2.6.2 Moving around the screen
As you use your application the Braille output will automatically show the
control you are currently on. If you are using Logical Mode, the Braille will
also show any text associated with the control.
You can use the navigation features to move the Braille display to show
other information, or to move the Braille along if the contents of the current
control will not fit.
The most important keys are the Read Backwards and Read Forwards
keys. These move the display along the line to show the previous and next
portions of the text.
Braille Navigation Hot Keys
Function
Move forward

Move backwards

Hot Keys
LEFT
CONTROL +
LEFT SHIFT +
PERIOD
LEFT
CONTROL +
LEFT SHIFT +
COMMA

Braille Buttons
FORWARD
command

BACK
command
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The distance the Braille will move is governed by a setting in the Control
Panel called the Scroll Margin. This value is set in the "General
Preferences" dialog box.
Other navigation keys that are available and will typically have Braille
Button assignments are:
· Line Start
This will move the Braille display to show the content at the beginning
of the line. This will also move the display to the beginning of any
incidental text when in Logical Mode.
· Line End
This will move the Braille display to show the content at the end of the
line. This will also move the display to the end of any incidental text
when in Logical Mode.
·

Width Left
This will move the Braille display to show the content one full display
width to the left.

· Width Right
This will move the Braille display to show the content one full display
width to the right.
· Half Width Left
This will move the Braille display to show the content half width to the
left.
· Half Width Right
This will move the Braille display to show the content half width to the
right.
· Cell Left
This will move the display to show the content one Braille cell to the
left.
· Cell Right
This will move the display to show the content one Braille cell to the
right.
· Line Up
This will move the display to show the content one line up.
· Line Down
This will move the display to show the content one line down.
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· Top
This will move the Braille display to show the content at the top left of
the window.
· Bottom
This will move the Braille display to show the content at the bottom
left of the window.
· Go to Focus
Move the Braille display back to the position of the focus.
The Go to Focus key will move the Braille back to the place where you
started navigation, i.e. to the current control. This can be particularly useful
when you are editing a document and wish to move straight back to the
cursor. Of course, if you type anything, the Braille will jump back
automatically, but this key allows you to return to the focus without affecting
your application.
Notes:
· If you move up or down, you will temporarily switch into Physical
Mode. Logical Mode is restored when you press Go to Focus.
· Any navigation from the Braille display is independent from the
Speech and Dolphin Cursor.
2.6.3 Change what Hal tells you about each type of control

You can control what Hal automatically tells you about a button, a check
box, a menu item or any other type of control by changing your Verbosity
Level. The lower the Verbosity Level, the less information Hal automatically
announces about the control.
To change Verbosity Level:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Verbosity Level" and RIGHT ARROW to open the
sub-menu.
4. Select a Verbosity Level and press ENTER to confirm your change and
close the menu.
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You can also change Verbosity Level using a Hal hot key.
To change Verbosity Level:
Press LEFT SHIFT + CAPS LOCK + EQUALS.
2.6.4 Move the cursor using the Cursor Routing buttons
Many Braille displays have buttons located above each cell, called Cursor
Routing Buttons. If you press one of these buttons then Hal will generate a
single mouse click at that corresponding position.
Examples:
· Pressing the Routing Button In an edit area has the effect of instantly
moving the cursor to that point.
· Pressing a routing button above a push button will activate the button.
· Pressing a routing button above a check box will toggle the state of
the check box.
Some Braille displays have a second row of Routing Buttons. This second
row can be used to describe the character at the corresponding position.
Change what the Cursor Routing buttons do
You can change what the Cursor Routing buttons do by changing settings
in the Hal control panel.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu.
4. Select "Routing Buttons" and press ENTER. This will open the "Routing
Buttons" dialog box.
5. Select the action you want the Routing Buttons to perform.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
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Change what the Cursor Routing buttons do while using the Dolphin
Cursor
You can change what the Cursor Routing buttons do while you are using
the Dolphin Cursor by changing settings in the Hal control panel.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu.
4. Select "Dolphin Cursor Options" and press ENTER. This will open the
"Dolphin Cursor Options" dialog box.
5. Select the action you want the Routing Buttons to perform.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
Change what the Cursor Routing buttons do above Status Cells
You can set Routing Buttons above Status Cells to perform Hal commands.
This provides a useful function for these buttons which otherwise would
have no purpose because their position means they cannot be used to
route the cursor.
Use the "Keyboard and Hot Keys" dialog box to add a Routing Button to a
command.
2.6.5 Check text attributes
Every character has a series of properties (attributes) associated with it,
such as its size, font and color.
You can learn a characters attributes by switching to Attribute Mode.
Two different Attribute Modes are available.
· Cycle Attributes.
· Describe Cell.
The Cycle Attributes function uses special dot combinations to show the
attributes of every character on the Braille display at once. By contrast,
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the Describe Cell function writes a full description of just one character on
the Braille display.
Braille Attributes Mode Hot Keys
Function
Hot Keys
Cycle the attributes of the
LEFT
characters shown on the
CONTROL +
display
LEFT SHIFT +
6
Describe the attributes of a
LEFT
single character
CONTROL +
LEFT SHIFT +
7

Braille Buttons
CYCLE
ATTRIBUTES
command
DESCRIBE
CHARACTER
command

Cycle attributes
The Cycle Attributes key will cycle through the various attributes of the
characters currently shown on the Braille display. Each cell will indicate the
attribute of the character that was at that position.
The Cycle Attributes command is a multi action.
1. Pressing the key the first time will display the size of each character.
2. Pressing the key again will display the style of each character.
3. Pressing the key again will display the foreground and background
colors of the characters.
4. Pressing the key again will display the foreground color.
5. Pressing the key again will display the font of the characters.
6. A final press of the key will return to normal mode.
As you cycle through the attributes and you press a key on the computer
keyboard or the Go to Focus command on the Braille display, then you will
return to the normal character display mode.
An explanation on the Braille output for each attribute is described below.
The precise meaning of the dots shown for some of the attributes displayed
with Cycle Attributes key may not be immediately obvious. The function is
provided so that it is easy to find when an attribute changes. You may
also find the Enhanced Characters function helpful.
Size
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The size of characters is shown as a two digit number representing the
point size. The upper four dots of the Braille cell are the tens digit and the
lower four dots are the units. For example, a ten point character is shown
by dots 1678 (A above J).
Style
The styles of characters are shown as follows:
· Dot 1: Italic.
· Dot 4: Underline.
· Dot 2: Struck out and/or non-normal color.
· Dot 5: Bold.
· Dot 3: Light.
· Dot 6: Selected.
· Dot 7: Link.
· Dot 8: Normal (i.e. not italic and not underlined and not struck out and
not bold and not light).
Color
The foreground and background are shown with the upper four dots
representing the foreground and the lower four dots representing the
background.
Foreground Color
The foreground attribute mode shows just the character’s foreground color
using all eight dots of the cell. The color is represented using the
red/green/blue (RGB) method: dots 123 show the amount of red, dots 456
show the amount of green and dots 78 show the amount of blue. White is
shown as all eight dots and black is shown as an empty cell.
Font
Each cell displays a symbol representing the character's font name. As
only a single character is used for the whole of the name, the symbol may
not seem related to the name it represents, for example the Arial font is
represented by dots 15678. To find the full name of the font, use the
Describe Character] function.
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Describe character
The Describe Character key will display a full description of the character at
the cursor position. This is useful if you want to find out what an unfamiliar
dot combination represents.
For example, if you find a symbol you do not understand:
1. Use the Cursor Route button to move focus to the character.
2. Press Describe Character to describe the character's attributes.
3. Use the Navigation keys to move along the description if it does not fit
on your display.
The description includes a description of the character itself together with
all the attribute information available. The information is written out in full.
You will see a description similar to the following:
"(Dots 467) POUND, Arial, normal, 14PT, Black, White, 00a3"
This shows:
· The character being described. In this example it is dots 467.
· The description of the character (the Pound sign).
· The font name of the character.
· The style.
· The size ("PT" is an abbreviation for "point").
· The foreground color of the character.
· The background color.
· The Unicode value of the character.
2.6.6 Show information on the Braille display Status Cells
Many Braille displays have a special group of cells to the left of the main
display area to display status information.
Hal can use these status cells to display extra information about the
character under the cursor, for example, its size and color.
You can show any of the following status information:
· Features on display.
· Cursor position across the line.
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· Type of the current focus.
· Any of the attributes of the character under the cursor
You can select as many options as you want, except that you will be limited
to the number of status cells you have on your Braille display.
Each option takes one cell.
Notes:
· Although your Braille display may not have dedicated status cells, you
may be able to simulate status cells using the SAM driver. To check
this, call up the Driver Configuration dialog box from the SAM Control
Panel. SAM can be opened from the "General Advanced Options"
dialog box.
2.6.7 Show Braille output on the screen
You can show what is being output to your Braille display inside a small
fixed window on the screen. This is the "Show Braille On Screen" item in
the "Braille" menu.
To turn the "Show Braille On Screen" option off or on:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + B. This will open the "Braille" menu.
3. DOWN ARROW to "Show Braille On Screen" and press ENTER. This
will confirm the change and close the menu.
You can also show or hide the window with a hot key:
Press LEFT CONTROL + LEFT SHIFT + 1.
You can change the position and size of the window through options in the
"Braille Advanced Options" dialog box.

2.7 Dolphin Cursor
The Dolphin cursor is a special kind of cursor created by Hal. The Dolphin
Cursor allows you to read the contents of the screen line by line, or word by
word, or letter by letter using your keyboard. You can use the Dolphin
cursor to review any part of your computer's screen.
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2.7.1 Turn on the Dolphin Cursor
You can turn on the Dolphin Cursor and position it either at the last place it
was located or at the current focus position.
Dolphin Cursor Hot Keys
Function

Turn on Dolphin Cursor
Turn on Dolphin Cursor and
position it at the current focus
position

Desktop Default
NumPad Set
NUMPAD
MINUS
NUMPAD
ASTERISK

Laptop Universal Set
CAPS LOCK +
Z
CAPS LOCK +
MINUS

2.7.2 Turn off the Dolphin Cursor
If you have turned on the Dolphin Cursor, then to turn off the Dolphin
Cursor you must use the following hot key.

Dolphin Cursor Hot Keys
Function

Turn Dolphin Cursor off
Turn off the Dolphin Cursor
and prevent the Dolphin
Cursor being automatically
turned on

Desktop Default
NumPad Set
NUMPAD
MINUS
CONTROL + 4

Laptop Universal Set
CAPS LOCK +
Z
No Assignment

The Dolphin Cursor also turns off automatically if something happens on
the screen, for example, a message window appears.
2.7.3 Select text using the Dolphin Cursor
You can select text from the screen using the Dolphin Cursor. Text includes
text from dialog boxes and message windows as well as text from web
pages and documents.
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To select text using the Dolphin Cursor:
1. Press SHIFT + Arrow Keys to make your selection or press CONTROL
+ A to select all the text in the current window.
2. Press CONTROL + C to copy your selection to the Clipboard.
3. Go to the place you want to insert the selected text.
4. Press CONTROL + V to paste the content from the Clipboard.

2.8 Highlight the focus

You can make different types of focus easier to see by adding a highlight
indicator. You can choose the style, color and behavior of the highlight.
To add a highlight to a focus
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + V. This will open the "Visual" menu.
3. DOWN ARROW to "Highlighting Options" and press ENTER. This will
open the "Highlighting Options" dialog box. Each property sheet in the
dialog box controls the highlighting options for a specific focus type.
4. Select the focus type you want to add a highlight too.
5. Select the first check box to turn on the highlight for this focus type.
6. If the default values are not suitable, use the options available to
choose a highlighting style.
TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.

2.9 Doc Reader

The Doc Reader lets you create your own reading environment, where the
text, background and highlight can all be set to a value that makes reading
comfortable for you. You can display text from documents, web pages or
any other source showing text on the screen.
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2.9.1 Start Doc Reader
The Doc Reader can be started from the "Visual" options in the Hal control
panel or by using a hot key.
Doc Reader Hot Keys
Function

Start Doc Reader

Desktop Default
NumPad Set
CAPS LOCK +
NUMPAD
PLUS

Laptop Universal Set
ALT + SHIFT +
D

Your text will be loaded into the Doc Reader. This may take a few seconds.
In the Doc Reader, you can use the Arrow Keys to move the highlight
through the text or press TAB to move through the Doc Reader toolbar
options.
To exit the Doc Reader:
Press ESCAPE.
2.9.2 Control the reading speed
You can change the reading speed in the Doc Reader. This value is
relative to your current voice speed.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + V. This will open the "Visual" menu.
3. DOWN ARROW to "Doc Reader Settings" and press ENTER. This will
open the Doc Reader Settings dialog box.
4. TAB to the "Doc Reader Speed" slider.
5. Use the Arrow Keys to change the slider position. The higher the value
the faster the reading speed.
6. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.

2.10 Make use of Settings Files
Settings can be grouped into the following broad categories:
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· Input Settings control what Hal understands about the environment it
is currently in. Map files and Script files hold this data.
· Output settings are the settings you can configure in Hal for an
application. Application Settings files and Situation Settings hold this
data.
· Global Settings are settings you cannot configure on a per application
basis. This includes hot keys, control panel settings, Update Settings
and Window Settings.
You can create, edit, import and export both the input and output settings.
You do this by choosing items from the "File" menu in the Hal control panel.
2.10.1 Create Application Settings
If you find you regularly adjust Hal output settings when working in different
programs, then using Application Settings can provide an automated
solution.
To create an Application Settings file:
1. Run the application you want to create an Application settings file for.
2. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
3. Press ALT + F. This will open the "File" menu with "New" selected.
4. RIGHT ARROW into the "New" sub-menu.
5. Select "Application settings" and press ENTER. This will open the
"Select Settings file" dialog box.
6. Select "Create a new settings file".
7. TAB to the "OK" button and press SPACEBAR. This will open the
"Create new Settings File" dialog box.
8. Give the new Application Settings file a name, choose whether to create
an empty settings file or copy an existing settings file and then TAB to
the "OK" button and press SPACEBAR. This will close the dialog box
and return you to the Hal control panel.
Your Application Settings file will now be in use. You can check the
Application Settings file currently in use by reading the Status Bar in the
Hal control panel.
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2.10.2 Create Situation Settings
If you find you regularly adjust Hal output settings when certain dialog
boxes appear in an application then using Situation Settings can provide an
automated solution. Situation Settings are a subset of Application Settings
and are stored within the same file.
To create a Situation Setting:
1. Run the application and get into the situation you want to create a
Situation Setting for.
2. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
3. Press ALT + F. This will open the "File" menu with "New" selected.
4. RIGHT ARROW into the "New" sub-menu.
5. Select "Situation settings" and press ENTER. This will open the "New
Situation Settings" dialog box.
6. Select "Create new Situation".
7. TAB to the "OK" button and press SPACEBAR. This will open the
"Enter a name for the new Situation" dialog box.
8. Give the new Situation Setting a name and then TAB to the "OK" button
and press SPACEBAR. This will open the "Windows Name" dialog box.
9. If required, adjust the Window Name and then TAB to the "OK" button
and press SPACEBAR. This will close the dialog box and return you t
the Hal control panel.
Your Situation Setting will now be in use. You can check the Situation
Setting currently in use by reading the Status Bar in the Hal control panel.

2.11 Resolve hot key conflicts
You can sometimes find Hal hot keys conflict with hot keys assigned to
commands in your application. You can resolve this issue in a number of
different ways.
2.11.1 Turn off Hal hot keys
You can resolve a hot key conflict between Hal and your application by
turning off Hal's hot keys. This disables all hot keys except for the hot key
to turn on Hal's hot keys again.
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Action Hot Keys
Function

Turn off or on hot keys

Desktop Default
NumPad Set
LEFT
CONTROL + 8

Laptop Universal Set
SHIFT + CAPS
LOCK + 3

2.11.2 Tell Hal to ignore the next key press
You can resolve a hot key conflict between Hal and your application by
telling Hal to ignore the next key press. Once you have released the keys,
Hal automatically turns on its hot keys again.
Action Hot Keys
Function

Pass the next key press
through to your application

Desktop Default
NumPad Set
LEFT
CONTROL + 7

Laptop Universal Set
CAPS LOCK +
3

2.11.3 Reassign a Hal hot key
You can add, delete or reassign any Hal hot key. You can do this to resolve
hot key conflicts between Hal and your application or to change a hot key
command to a key combination you find easier to use.
To do this:
1. Press LEFT CONTROL + SPACEBAR. This will open the Hal control
panel.
2. Press ALT + G. This will open the "General" menu.
3. DOWN ARROW to "Keyboard and Hot Keys" and press ENTER. This
will open the "Keyboard and Hot Keys" dialog box.
4. CONTROL + TAB to the "Hot Keys" tab.
5. Use the "Hot Key Command Set" list and "Command" list to select the
assigned hot key you want to change.
6. Use the "Add key" button, "Replace key" button or "Remove key" button
to change the hot key.
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7. TAB to the "OK" button and press SPACEBAR. This will confirm your
changes and close the dialog box.
If you find it difficult to locate your hot key from the categories and
commands available then use the Hal Key Describer to help.

2.12 Network Hal
2.12.1 Network Installation
To complete the network installation, you will:
1. Install Hal to the file server.
2. Activate Hal.
3. Configure workstations to run Hal.
4. Set the user's Hal settings folder.
Preparation
To ensure a successful network installation you will need the following:
· A folder on the file server that you can install the software to. You will
install all Hal components to sub-folders inside the folder and all users
should have Read permissions to this folder and subfolders.
· All users should be able to access this folder using the same network
name (UNC path, share name, etc).
· Each user should have a private folder. This can be part of a roaming
profile or just a personal folder. The user's private folder can be on
the network or on their local machine if they always use the same
machine.
· Administrator access to all workstations.
Step 1: Install Hal to the file server
To do this:
1. Log onto a workstation or onto the file server, using a user account that
has permission to write to the chosen folders on the file server.
2. Run the Dolphin installation program from the product CD-ROM.
3. In the install program, select the install language and then choose the
"Next" button to move on to the next screen.
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4. Select "Network" as your product version and then choose the "Next"
button to move on to the next screen.
5. If the install program sees a previous version on the file server, then
you must choose either to create a new install or update the existing
install. Make your selection and then choose the "Next" button to move
onto the next screen.
6. Move through the "Welcome", "Readme" and "End User License"
screens by choosing the "Next" button.
7. Select "Custom Installation" and then choose the "Next" button to move
on to the next screen.
8. Follow the on-screen instructions to complete the install program,
ensuring that you enter the UNC path for the destination folder for each
component, for example, \\server1\programs\dolphin\Hal\.
Installation to the file server is now complete.
Step 2: Activate Hal
Product activation is required in order to obtain a software license for Hal.
Without a software license Hal will run for only 30 days.
You will require your Hal software license certificate to activate Hal. Note,
you may have received your certificate separate to the software.
To activate Hal:
1. Locate and run the EXE to launch Hal. You will find the EXE in the Hal
installation folder.
2. When Hal starts, a message window will appear asking you to install
the Dolphin Interceptor driver. You can skip this action by choosing the
"No" button. The Dolphin Interceptor driver is only required on
workstations that will be running Hal.
3. Next, the product activation window will appear. This will tell you that
activation is still required and of the number of days remaining before
Hal times out.
4. Select "Activate now" to start the activation process.
5. Select the "Multi user license" button.
6. Enter in the multi user license code stated on your software license
certificate.
Product activation is complete.
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Step 3: Configure workstations
You must configure each workstation to run Hal: You maybe able to
automate these steps with login scripts.
1. Logon as the Administrator or someone who has security equivalence.
You will need permission to write to the installation folder.
2. Locate the Hal installation folder on the network using Windows
Explorer and run the program "Netinstall.exe". You should get a
message saying "Interception driver installed and configured
successfully". If you get any other message then you probably do not
have sufficient security permission.
3. Log off and re-start the machine.
The configuring of the workstation is complete.
Step 4: Set the user's Hal settings folder
New users begin with the Hal Setup Wizard. This will guide them through
different Hal choices. To save their settings a folder must be available that
Hal can write too. Users will enter this location at the end of the Setup
Wizard unless a path is already stated.
To avoid the user needing to enter a folder location, you must add an entry
to the registry. You need to enter the following key:
HKEY_CURRENT_USER\Software\Dolphin\Hal
String Value Name: Settings
String Value Data: [type folder location]
2.12.2 Uninstall network version
To remove the Dolphin interceptor driver from the workstation:
1. Logon to the workstation as an Administrator, or someone who has
security equivalence.
2. Open the "Run" dialog box.
3. Select the "Browse" button and locate the file "Dolcfgnt.exe" in the
folder containing Hal.
4. To the "Open" line in the "Run" dialog box, add the command line
switch -r. For example,
\\server\dolphin\snova\dolcfgnt.exe -r
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5. Select the "OK" button and you should get a message saying
"Interception driver successfully removed". If you get any other
message then you probably do not have sufficient security permission.
You can now remove all workstation shortcuts, personal Hal settings files
and component directories on the file server.
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